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What is FlingIt? 
FlingIt™ allows you to “fling” – copy in its entirety – a web page from your desktop 
computer to your Palm handheld.  You may then view and read the web page on 
your handheld at any time you’d like.  FlingIt works great for news stories, 
encyclopedia snippets, and color photos, as well as other additional educational 
resources. 
 
 
 
System Requirements 

• Palm OS Compatible Handheld with OS version 3.5 – 5. (Palm OS 4.1 – 
5 recommended.) 

 
• Macintosh OS 9.x: (Macintosh OS X recommended) 

(See “known issues” below) 
Palm Desktop 4.1.  
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Internet Explorer 5.0 or higher 
 

• Macintosh OS X: (See “known issues” below) 
Palm Desktop 4.1 
One of the following Web browsers: Internet Explorer 5.0 or higher, 
Safari, Camino, Chimera, OmniWeb, Opera, Mozilla (Netscape does 
NOT work), or iCab (Internet Explorer recommended.) 

 
• Windows: Windows 98 or higher, running Palm Desktop 4.0.1 or higher. 

(Palm Desktop 4.1 recommended) 
Internet Explorer 5.0 or higher. 

 
• 234 KB memory on Handheld needed for full installation.  

(file(s) include: FlingIt.prc, SysZLib.prc) 
 
 

 
Before using FlingIt 
FlingIt must be installed onto your desktop computer AND your handheld device 
before it will properly work.  While FlingIt sites may be beamed from handheld to 
handheld freely, assuming that each handheld has FlingIt installed, to initiate a 
transfer from a desktop computer to handheld FlingIt must also be installed on said 
desktop computer.  
 
 
 
Getting Started 

1. This document is divided into three main sections.  
2. The first two sections describe how to use FlingIt on either Macintosh or 

Windows-based desktop or laptop computers.  
3. The third section describes using FlingIt on the handheld. The third section 

applies to all users, independent of which type of desktop computer “flung” 
the site. 

 
 
 
 
 
Clarifications/Known Issues 

1. m130 model Palm handhelds will NOT work with FlingIt on computers 
running Mac OS 9.x. This is caused by an inconsistency in the way Mac OS 
9.x handles the USB transfer with this particular piece of hardware. 
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2. Not all models of Palm OS devices work with FlingIt on Mac OS X! The 
following models have been incorporated into the Mac OS X FlingIt 
program, and tested: 
 
AlphaSmart Dana 
Palm m125 
Palm m130 
Palm m500 
Palm m505 
Palm Tungsten T 
Palm Tungsten C 

Palm Zire 71 
Tungsten T3 
Tungsten E 
Palm Zire 
Palm Zire 71 
Sony PEG-TJ35 
Sony Clie PEG-TG50 

 
FlingIt will not work with serial handheld such as the m100, and Palm IIIc on 
Mac OS X 
 

3. The Mac version of FlingIt does not operate behind a proxy server.  
 
4. There are substantial differences in the FlingIt procedure between 

Macintosh and Windows. If you use both types of computers, or have both 
operating systems in your school, please make sure to read both sections 
below.  

 
 
Setting Up FlingIt for the Windows Desktop 

1. After installation, perform the following one-time setup procedure to ensure 
that FlingIt will work properly with possible school firewalls and proxy 
settings. 

2. Open Internet Explorer, and click the FlingIt icon. The FlingIt icon is usually 
located at the rightmost end of the standard toolbar (Figure 1). 

 

 
Figure 1 

 
3. In the Setup menu, click Proxy (Figure 2). 
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Figure 2 

 
4. FlingIt may attempt to auto-detect your computer’s proxy settings. If the 

desktop computer uses a proxy server, enter the information in the space 
provided (Figure 3). Some schools also require a username and password. 

 

 
Figure 3 

 
5. Finally, click Change Transport Settings in the Setup menu (Figure 4) to 

verify that the settings match the method your handheld uses to 
synchronize. (e.g. serial, USB)  
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Figure 4 

 
 
 
Flinging Web Pages from Windows 

1. First find a website you would like to send to your handheld. Keep in mind 
that there are three types of websites that might have unexpected results: 

a. Websites that are password protected will not work.  
b. Websites with numerous frames will be difficult to view on the 

handheld 
c. Sites containing any animation, sound, etc. will not display said 

effects on the handheld. 
2. Click the FlingIt icon. A new gray window opens. Under the Color Depth 

menu (Figure 5), decide whether graphics should be sent to the handheld, 
and if so, determine the quality. 

 

 
Figure 5 

 
3. Next click the Link Depth menu to determine how many linked pages 

connected to the page you are viewing should be sent to the handheld 
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(Figure 6). For example, a link depth of “1” means that you will only fling the 
page you are looking at. “2” would send the page you are currently viewing, 
AND every page connected to the page you are looking at. 

 

 
Figure 6 

 
4. Take note that if there is a check next to Offsite Links in the Link Depth 

menu, all connected sites will be sent to the handheld. If the menu option is 
unchecked, only sites beginning with the URL of the site you are currently 
viewing will be sent to the handheld. 

5. Now that you’ve set the Color Depth and the Link Depth, you’re ready to 
“fling” the page. To initiate the process, use the mouse to click FlingIt. A 
black window with much text will appear. This screen is FlingIt working to 
bundle, compress, and prepare the site for distribution to the handheld. 
(Some large sites with numerous links and graphics can take a long time, 
especially with a slow connection speed.) The screenshot below (Figure 7) 
shows a student flinging a site about seals for later study. 
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Figure 7 

 
 
 
Transferring the Web Site to the Handheld Computer (Windows) 

1. Once the FlingIt process has been initiated, you are free to navigate to 
other web pages. 

2. Once the process of preparing the web site has been completed, the Palm 
Install Tool, or Palm “Quick Install Tool”  (Figure 8) will appear. 

  

 
Figure 8: (Palm Desktop Install Tool) 

 
3. Make certain that the user who should receive the web site appears in the 

username window. 
4. Once the appropriate user is selected, click OK.  
5. Alternatively, if you ARE using Palm Quick Install, a new window opens 

similar to Figure 9. The FlingIt database file, FlingIt.pdb, appears in your 
Files to Install. Select the user who should receive the web site from the 
User pull-down menu, and click OK. 
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Figure 9: (Palm Desktop’s “Quick Install”) 

 
6. Synchronize the handheld to transfer the Web site from the desktop or 

laptop computer to the handheld computer. 
7. NOTE: You cannot “Fling” numerous sites and then synchronize once at the 

end. The pattern must be: Fling—Sync, Fling—Sync, and so on. 
 
 
 
Setting Up FlingIt for the Macintosh Desktop 

1. After installing FlingIt make sure that you Quit Internet Explorer and restart 
it.  

2. You may also have to restart the computer for the installation to take 
effect. 

 
 
 
Flinging Web Pages from a Macintosh 

1. First find a website you would like to send to your handheld. Keep in mind 
that there are three types of websites that might have unexpected results: 

a. Websites that are password protected will not work.  
b. Websites with numerous frames will be difficult to view on the 

handheld 
c. Sites containing any animation, sound, etc. will not display said 

effects on the handheld. 
 

 
Figure 10: FlingIt icon as appears on OS X 
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Figure 11: FlingIt menu as appears on OS 9.x 

 
1. Click the FlingIt menu. On Mac OS X, Chose the Resolution of the graphics 

(assuming you want graphics on the handheld). Next click the Link Depth 
submenu (Figure 12) to determine how many linked pages connected to the 
page you are viewing should be sent to the handheld. For example, a link 
depth of “1” means that you will only fling the page you are looking at. “2” 
would send the page you are currently viewing, AND every page connected 
to the page you are looking at. 

 

 
Figure 12 

 
2. On Mac OS 9.x notice that the images and link depth options are located 

under Options (Figure 11). 
3. Take note that if there is a check next to Offsite Links in the Link Depth 

menu, all connected sites will be sent to the handheld. If the menu option is 
unchecked, only sites beginning with the URL of the site you are currently 
viewing will be sent to the handheld. 

 
 
 
Transferring the Web Site to the Handheld Computer (Macintosh)  

1. After you have selected options for images and link depth, select Fling this 
page from the menu. 

2. FlingIt will prepare the Web site (Figure 13). Time will vary depending on 
the size of the site, how many links you’ve selected, image quality chosen, 
and the speed of your connection. 
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Figure 13 

 
3. Once the site has been prepared (Figure 14), verify that the handheld is in 

the cradle.  
 

 
Figure 14 

 
 

4. Go to the FlingIt program on the handheld, and tap Download site (Figure 
15). 

 

 
Figure 15 

 
5. The information will be downloaded to the handheld automatically. There is 

NO synchronization required. 
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Using FlingIt on the Handheld Computer 

1. Once Web content has been sent to the handheld, whether it is initiated by 
a Windows or Macintosh computer, the following instructions apply. 

2. This section will describe how to open and beam sites, as well as how to 
change font size, find keywords and more. 

 
Opening a Web Page 

1. There are two ways to enter FlingIt (Figure 16).  If you’d like to view web 
content you have already sent to your handheld, tap Open. 

2. To view your last website, tap Last.  
 

 
Figure 16 

 
3. Note: The Download site button applies only to Mac users who are 

downloading new content to their handhelds! Windows users should act as 
if the Download site button does simply not exist! 

 
View Downloaded Sites on your Handheld 

1. Tap and hold the site to bring down a menu (Figure 17) of advanced 
features such as rename, categorize, and beam. Just tapping the desired 
site quickly will open the site for viewing by default. 

 

 
Figure 17 
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The Toolbar 
1. There are many options available in the Toolbar (Figure 18) to enhance your 

viewing experience. 
 

 
Figure 18 

 

2. :  Opens the Menu Bar, where you can access the Go, View and 
Options menus. 

:  Takes you to a list of previously downloaded sites – the Open Site 
Menu. Tip: This is the best way to switch between sites. 

%:     Shows what percent of the website has been read. 
:  Searches for particular words on the page. The left lens is find and 

the right lens is find next. 
  :  Acts like a normal web browser, with back, home, and forward  

buttons. 
 
 
 
Menus 
The Go Menu 

1. Tap the Go menu (Figure 19) to bring up: 
• Open site: Opens a previously downloaded site. 
• Delete site: Permanently deletes viewed site viewed if confirmed. 
• Beam site: Initiates beaming of site to receiving handheld. 
• Download site: Mac users only—begin transfer process. 
• Find: Searches for specific words in the current page. 
• Find Again: Searches for the next occurrence of keyword. 

 

 
Figure 19 
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The View Menu 
1. Tap View then Details to bring up a screen that lists the URL, as well as 

gives the option to remove images after the fact (Figure 20).  
 

 
Figure 20 

 
2. Tapping Copy URL will store the address in the clipboard. To paste, 

navigate to your favorite word-processing program and bring up the paste 
command. This is a great way for students to list their resources and pull up 
web sites on home or school desktop computers. 

 
The Options Menu 

1. The Options menu (Figure 21) allows you to select a number of font sizes 
and formatting options. 

 

 
Figure 21 

 
 

Additional Support 
 
Additional support and user information can be found at 
http://www.goknow.com/Support/. 
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If you have any questions or concerns, please contact: support@goknow.com. 
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